
Gambling Games
See
Card Games

Game Editors
See
Crystal Crazy

Games
See
Entertainment; Simulation Games; Roll Playing Games; Adventure Games;
Strategy Games

Gaming
See
Entertainment
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Gaming Services on the Internet
See
Online Live Games

Gamma Curve
See 
Image Scanning

Gamma Values in Scanners
Most scanning software supports the concept of gamma correction: rather
than adjusting the brightness of a scan by changing all the light and dark
pixels in the same way; light and dark pixels are adjusted differently to
improve the balance and contrast of the image. It’s almost always better to
adjust tonal values with gamma controls rather than simple
brightness/contrast controls.

Software controls for setting gamma value controls vary widely, but many
packages allow you to enter gamma values directly. lowering a scan’s gamma
value from the default value of 1.0 darkens the scan; increasing the gamma
value lightens the scan.

See Also
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Scanners

Gantt Charts
See 
Plan & Track

Garfield Virus
See 
MDEF Virus

Gassée, Jean Louis
Jean-Louis Gassée took over as general manager of Apple France in 1981
after working for Hewlett Packard and Data General. Gassée was extremely
successful there; Apple computers even outsold IBMs in France.

Gassée was brought in on the Macintosh project when Steve Jobs  and John
Sculley  were in the midst of their falling out. He was ostensibly the
Macintosh marketing director, but Sculley wanted him running the entire
Mac division instead of Jobs. Gassée was extremely reluctant to get involved
in the mess the Mac division had become, but was finally convinced to take
the job.
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When Jobs began plotting to oust Sculley, it was Jean-Louis Gassée who
warned Sculley. When Jobs left Apple, Gassée became the head of product
development at Apple. Though not an engineer, Gassée is a brilliant marketer
and a visionary. He left Apple in 1990 and now heads Be, Inc., in San Jose,
California.

Be is a new computer company that manufactures a unique multiprocessor
computer targeted at technology enthusiasts. The computer, known as the
BeBox, uses two (or more) PowerPC microprocessors and a new operating
system (BeOS) that takes full advantage of the power of multiprocessing.

See Also
Jobs, Steve; Sculley, John

Gatekeeper
Gatekeeper is a free System extension /INIT developed by Chris Johnson
designed to protect your system against the WDEF  virus that infects the
invisible desktop file  on disks of all types. Gatekeeper was originally
introduced back in 1990 when the WDEF virus was spreading rapidly—it would
infect a hard disk and then transfer the virus to any inserted disks.
Gatekeeper was designed to keep the desktop file from being altered by the
WDEF virus.

Gatekeeper also stops unknown suspicious activity in the hopes of
preventing virus attacks. Many genuine applications perform activities that
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resemble virus attacks. Gatekeeper can learn which routines should be
allowed and which should be prevented. Codes can be entered into Gatekeeper
to allow it to detect (but not remove) new viruses.

The proliferation of commercial virus detection software has made an
appearance of the WDEF virus very rare.

See Also
Anti-Virus; Extension; Desktop File; Virus; WDEF

Gateway
See 
Internet Services

GCR (Gray Component Replacement)
GCR, or gray component replacement, is a technique used in process color
printing  to reduce the amount of ink needed to cover an area in the printed
image. A variation of UCR  (undercolor removal), GCR helps control ink
trapping and reduces ink cost.

When three process colors (cyan, magenta, and yellow) mix and two
predominate to create the hue, the third color determines the grayness of the
mixture. In GCR, this gray component is replaced with black in varying
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percentages so that there are never more than two primary colors plus
black. This is also called achromatic reproduction, and it affects all the colors
in an image.

See Also
Color Printing; UCR (Undercolor Removal); Ink Trapping; Process Color

General Controls Control Panel
This control panel enables you to personal preferences for  your system
including: The rate at which the cursor  blinks while waiting at an insertion
point; how many times a menu item  blinks when selected; whether or not
you want to see items on your desktop  when it’s in the background (such as
your hard drive , disks, the trash can , and so on); whether you want to
lock your System Folder  or Applications folder to keep other users from
accidentally removing items; whether you want the Mac to display a warning
dialog box if the Mac was shut down  improperly; and the default location
you want when you save a file.

All of these preferences are available to make working on your system more
convenient. To select any of these options, click the check box or radio
button  beside your selection.

To set your preferences in the General Controls Control Panel, follow these
steps:
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1. Open the General Controls Control Panel from the Control Panels
submenu on the Apple menu (or System Folder).

2. Set your preferences by selecting the options you want.

3. Close the General Controls Panel.

See Also
Cursor; Desktop; Hard Drive; Menu Item; Radio Button; Shut Down; System
Folder; Trash Can

General Magic
General Magic was founded by three former Apple employees in 1990 to
develop software for personal digital assistants (PDAs). Apple, Sony, and
Motorola are all major investors in General Magic.

General Magic might have been just another Silicon Valley startup if not for
its major investors and the names of the three founders: Bill Atkinson ,
creator of HyperCard, MacPaint, and the Mac’s graphics engine, QuickDraw;
Andy Hertzfeld, who wrote much of the original Macintosh Toolbox ; and
Marc Porat, former manager of business development for Apple’s Advanced
Technology Group.

There are two significant software developments created by General Magic.
The first is the MagicCap operating system. This OS is used in PDAs from Sony
and Motorola. The second is a technology called TeleScript, a language for
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creating intelligent software agents that can complete tasks without user
intervention.

See Also
Atkinson, Bill; Toolbox

General MIDI
The original MIDI  specification failed to map specific patches (sounds) to
MIDI ID numbers. Different manufacturers used different numbers to
identify similar sounds, resulting in unusual results when playing a MIDI
file on a different keyboard to the one it was created for. General MIDI fixed
that problem by assigned specific types of sounds to specific ID numbers. For
example, an electric guitar is always #28, and an acoustic grand piano is #1.
Drums are always on channel 10, with specific notes representing different
drum parts; a kick drum is note 36 of patch 10.

See Also
MIDI

Generic Icons
The invisible desktop file  on your Macintosh keeps track of all the file
icons  on your hard drive . Over time, this file becomes larger and larger as
it keeps track of every icon added and deleted to your hard drive, and
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occasionally it needs to be rebuilt to operate properly. If you have not
rebuilt the desktop  on your recently, the custom icons that normally
appear on your files may start to revert to black and white generic icons. The
generic icon for an application is a white diamond with a hand holding a
pen. The generic icon for a document is a blank white page.

This either means that the icons have lost their bundle bits, and rebuilding
your desktop may remedy the situation, or that the application that created
the document is not on your hard disk, so your system treats it as a generic
document and gives it a generic icon. The bundle bits are small bits of code in
the file used to link a document's icon to the application that created it. When
you create a document in Microsoft Word, for example, the icon looks very
similar to Word's own icon. And if you double-click this icon, you system
knows it's a Word document and launches Word for you. However, if the icon
lost its bundle bits, or they somehow got corrupted, it would still be a Word
document, but it would not know it was a Word document, and this link back
to the application (and matching icon) would be temporarily lost. So when
the Mac doesn't recognize this document as a Word document, it gives it a
generic icon.

So if you have the application that created the document, the document may
have a bundle bit problem. You can use a repair utility program to fix this
situation. Both Norton Utilities and MacTools can repair most common bundle
bit problems, and you can also try Apple's free repair utility Disk First Aid,
which is on the DiskTools disk of system install disks that you got when you
first purchased your Mac. (Note: If you have a CD-ROM install disc, there is a
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Disk Tools folder on the CD-ROM, and Disk First Aid is in that folder.)

See Also
Desktop File; Hard Drive; Icons; Rebuilding the Desktop

GeoPort 
Beginning with the AV Macs (the Quadra and Centris 660AV/840AV) Apple
replaced the standard modem Serial port  with a new connector called the
GeoPort. The presence of a GeoPort type serial port can be noted by the
looking for an additional ninth pin in the serial connector. The ninth pin
carries power from the Mac to a device called a GeoPort Telecom Adapter or
Phone Pod. This is a little box that, combined with the internal hardware in
these Macs, can replace a modem.

The GeoPort technology takes advantage of the Digital Signal Processing
chips in the AV Macs to let the computer itself take on many of the functions
previously performed by the modem. With old style modem technology, the
computer would send a modem a digital signal, which the modem converted to
an analog signal and sent out to the telephone lines. (See Modems  for
additional details).

All Power Macs have GeoPort-enabled printer and modem ports, as do the
older Centris 660AV, Quadra 660AV, and Quadra 840AV. GeoPort-enabled serial
ports have the ability to transmit data at 115,000Bps, faster than ordinary Mac
serial ports, which have a limit of 56,000Bps. This is faster than ordinary
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modem traffic, but is useful when modems use compression and when you are
connecting to ISDN  lines. GeoPort connectors look the same as the traditional
round Mac serial ports, but have 9 pins, one more than the traditional Mac
serial ports.

To connect to an analog telephone line  or a digital ISDN line , GeoPort
requires the use of a telecommunications adapter. The most common is the
Apple GeoPort Telecom Adapter (see the following figure), which connects to
standard telephone lines. Like a modem, the Adapter has two connectors, one
for a telephone line and one for a telephone.

The first ISDN adapter for GeoPort is the Sat-Sagem SPIGA, which has two
ISDN B channels at 64Kbps each, which can be combined.

There are several advantages to using a GeoPort adapter and a software
modem instead of ordinary modem, and a few disadvantages. One advantage is
that there is some really innovative telephony software available that is easy
to set up, use, and manage. For instance, MegaPhone from Cypress research
turns your Mac into a full-duplex speaker phone, which means that you and
the party at the other end of the line can speak at the same time.

Another advantage is that you can use the same line for both fax and voice
without having to turn anything on or off. The Express Modem software can
recognize what type of call is received and use the appropriate software, fax
or voice, to either answer the call or let you answer it.

Another bonus is that upgrades can be inexpensive software-only additions.
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At press time, Apple was expected to offer a 28.8Kbps software upgrade for
the Apple GeoPort Telecom Adapter sometime during the summer of 1996.
Previous to this upgrade, the top speed of the Express Modem and the Apple
GeoPort Telecom Adapter was only 14.4Kbps, which is one of the
disadvantages to using GeoPort technology.

There is also an annoying incompatibility with the Power Macintosh 7200
series, the 7500/100, the 8500/120, and the 9500 series. With these machines,
you must disable LocalTalk in order to use a GeoPort Telecom Adapter by
disconnecting any devices attached to the printer port. (Serial printers,
which are not LocalTalk devices, can remain attached).

The GeoPort lets the Macintosh perform this translation from digital to
analog and back again without the need for a modem. To use the GeoPort, you
simply connect a GeoPort Telecom Adapter to your telephone line and into
the GeoPort on your Mac. The Adapter is about the same size as a mouse and
has, in addition to the GeoPort cable and connector, a pair of phone jacks
(incoming and outgoing).

The GeoPort provides for backward compatibility with existing serial
products, in addition to its new features set. You can plug an ordinary modem
or fax/modem into the GeoPort or use any other device that attaches through
a conventional serial port. The extra pin socket won’t interfere.

The GeoPort technology makes the Mac uniquely suited to answer and process
incoming telephone calls. It’s bundled with ApplePhone software, which lets
your AV Mac turn itself into a phone-answering machine and speakerphone.
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By giving computer the power to interface directly the Mac can act as a
complete voice mail system, in addition to processing standard data and fax
telephone calls. ApplePhone has a screen display that mimics a real phone
and answering machine, right down to the blinking lights.

See Also
Express Modem; ISDN; Modems

GeoPort Adapter
See 
Ports, Types of

GeoPort Telecom Extension
This extension is used when utilizing Apple's GeoPort features that enable
you to connect a phone line, through a special GeoPort adapter, directly to an
AV or Power Macintosh model for use in telecommunications.

See Also
Modems; Extensions
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Gershwin
See 
System 9

Get Info Command
The Get Info command shows you information on the item you request by
pressing -I. To get information on an item, click the item and select Get
Info from the File menu . The Get Info box is available for any item that has
an icon: files, folders, documents, graphics, applications, and so on. If you Get
Info on an alias  of a file, its Get Info box tells you where the original is and
there’s a "Find Original" button to help you locate that original.

Get Info works only when you're in the Finder . When you select Get Info, a
window is displayed with the item’s information, including: the kind of
document (a Microsoft Word document, a PageMaker document, and so on),
the size of the document, where it is located, when it was created, a version
number (if applicable), and so on.

Below this information area is a Comments box  where you can enter any
comments you might have about this particular document. These comments
do not appear in your document; they appear only in this box. The nice thing
is that comments you put in the Comments box are searchable using the Find
File  command.
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Just below the Comments box is the Locked checkbox. If you click the Locked
checkbox, it locks that item so that it can't be altered or accidentally thrown
away. If the file is already locked (an "X" appears in the checkbox), clicking
the locked checkbox unlocks the file.

This is especially helpful if you have children using your Mac; you can lock
any files you fear may be accidentally thrown away, such as applications or
important system files.

To the right of the Locked box is the Stationery Pad  checkbox, which
enables you to turn this item into a template. If, for example, you design an
elaborate form layout and think you'd want to use this form again, rather
than redrawing the form from scratch each time you need a form, you can
save that document as a template (stationary pad) by clicking the Stationary
Pad checkbox. Any document that has been converted to a stationary pad gets
a slightly different icon resembling a note pad with dog-eared corners to let
you know it's a template.

The Get Info box is also where the item’s icon  is stored and where you can
customize an icon. The file's current icon appears in the Get Info window to
the left of the name of the file. To copy this file’s icon, click the icon in the
Get Info window. A square border appears around the icon to let you know it
has been selected. Go to the Edit menu  and select Copy  ( -C) to make a copy
of the icon. That icon is now in the Clipboard  where you can transfer that
icon to the file of your choice. To place that icon on another file, find the file
that you want to have the new icon, click it, and select Get Info from the File
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menu. Click that file's icon in the Get Info window. Again, a box appears
around the icon letting you know it's selected. Then choose Paste ( -V).
This pastes the icon in the Clipboard onto the existing icon. Close the Get Info
window to see the results, as shown in the figure.

If you Get Info on a program, rather than a document, the program's
memory requirements  appear in the lower-right corner. This is
important information for a number of reasons. The first number is the
minimum amount of memory the manufacturer has recommended for this
program to operate properly.

The second number appears in a box where you can input your own
minimum memory requirements, making it higher or lower than the
manufacturer's recommendations. Assume, for example, that 158K is the
minimum requirement, and you decide to set it at 100K. When you try to close
the Get Info window, you get a dialog box alerting you, "You have set the
minimum size below 158K and this may cause the program to crash. Are you
sure you want to continue?" (Having virtual memory turned on, by the way,
will significantly lower the memory requirements for PowerPC-native
programs.)

The last box enables you to input how much memory you'd prefer this
program to use. If you have a program, for example, that is memory
intensive, such as Adobe Photoshop, and you have 48MB of RAM on your
computer, you may want to Get Info and assign more memory than the
suggested minimum. You may want to assign 24MB just for Photoshop so that
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it uses the fastest memory possible: RAM.  To do so, type the number 24,000
in that field and close the Get Info window. The next time you launch Adobe
Photoshop, you have 24MB of your 48MB total set aside just for Photoshop.

To Get Info on a file, document, folder or application, follow these steps:

1. Click the item you want to Get Info on.

2. Select Get Info ( -I) from the File menu.

3. The Get Info window displays the item’s information.

4. To lock the item to keep it from being deleted or altered, click the
Locked checkbox.

5. To turn the document into a stationary pad, to use as a template, click
the Stationary Pad checkbox.

6. If the item is an application, you may adjust the memory allocation for
that application by entering new figures in the appropriate boxes.

7. If you want to leave a comment about this particular file, you may do
so in the Comments box.

8. If the file is an Alias, the Get Info gives the location of the original
file, and it has a locate original button to find the original file which
the alias was created from.

See Also
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Alias; Application Memory; Clipboard; Comments Box; Copy; Edit Menu; File
Menu; Find File; Icon; Locked; MB; Memory Requirement; Paste; RAM;
Stationery Pad

Get Info (Keyboard Shortcut)
After selecting a file, you can bring up the Get Info  keyboard shortcut by
pressing -I. You can also get info on a disk, a drive, and even the trash can
use the same keyboard shortcut.

See Also
Get Info Command; Keyboard Shortcuts; Trash

Ghosting of Disk
See 
Eject Disk Command

GIF
Originally developed by the online service CompuServe , the Graphics
Interchange Format (GIF) for bitmapped graphics  is commonly used for
graphics displayed on the World Wide Web and exchanged on the Internet. It
incorporates a compression  technique that reduces the file size with no
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degradation in quality.

Often pronounced “jif” (like the peanut butter), GIF is one of only three
graphic file formats officially supported by HTML for inline graphics on
Web pages. The other two formats are Unix-only, so GIF is the lingua franca
for online and Internet graphics use.

Not only is it a bitmapped graphic, it’s an Indexed Color bitmapped graphic,
which means it uses a color table limited to a maximum of 256 colors. The idea
behind indexed color is to a have a reduced color palette that can be recreated
by the standard 256-color monitor. Indexed color graphics look OK on screen
but tend to print out poorly.

Photoshop has a new plug-in that allows images to be exported as GIF89a files,
the newer GIF format that supports transparency (certain colors being
transparent) and interlacing (the “venetian blind” effect that makes an
image fill in strips on screen.

See Also
Bitmapped Graphics; CompuServe; Image Compression

GIFConverter
Shareware ($30-$45) program by Kevin A. Mitchell that converts edits
graphics files in a wide variety of formats. Especially useful in preparing or
converting files for presentation on the World Wide Web,  the graphical
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part of the Internet .

Installation is simple: download GIFConverter from the Internet, and double-
click the program to launch it.

To convert a file, simply choose “Open” from the “File” and navigate to the
document. Choose “Save as” from the “File” menu. Choose a new graphics
format from the pull-down menu in the window that opens on screen.

Like other graphics conversion programs such as GraphicConverter,
GIFConverter also lets an author manipulate images and select color palettes
and resolution.

See Also
GIF; GraphicConverter; Internet; Multipart GIF Images; Transparent Images;
World Wide Web

Global Village OneWorld Combo
See 
Modems

Glow
Glow defines the luminance of a 3D object. A luminous object appears bright,
as if glowing from within. A glow parameter or a glow map creates surfaces
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of objects, such as neon tubes. Depending on the rendering  software, an
object that glows may or may not cast light on another object.

A glow map is an image file that adjusts the appearance of the glow emitted
by the object. Not all software supports this feature.

See Also
Rendering; Shaders; Texture Mapping

God Games
See 
Strategy Games, Afterlife

Golf Games
See 
Links Pro CD for Macintosh, PGA Tour Golf III, Sports Games

Go-Moku
See 
Classic Collection
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Gopher
Gopher, one of the most extensive Internet services , is distinctive for its
ease of use and flexibility. Gopher originated with the Golden Gophers of the
University of Minnesota. More than 1,500 sites on the Internet run the host
Gopher software, which makes information available online so users can
“go-fer” it.

Gopher can be likened to File Transfer Protocol (FTP)  as a standard for
information retrieval on the Internet, with one major difference: Gopher
works only for retrieving rather than sending data.

Gopher can boast several major advantages over FTP, but has obvious
disadvantages over graphical browsers, as shown in the following table.

Gopher: Pros and Cons

Advantages Disadvantages

Provides a much friendler interface than the standard command-line FTP
client.Uses character-based rather than graphical environment.

Provides access to more types of information resources than FTP[em]online
phone books, online library catalogs, WAIS databases, email directories,
Usenet news, and Archie. Users navigate in a hierarchical, linear fashion;
through levels of folders, in order to find information.

Pulls its various information sources together under a single interface and
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makes that information available from a basic menu system. Gopher lacks the
Web’s novelty, excitement, and use of multimedia.

Uses less net bandwidth than FTP.

Gopher sites are interconnected; users can move from one to another
seamlessly.

TurboGopher , the most popular Gopher client for the Macintosh, was also
created at the University of Minnesota. It has the fastest perceived speed of
any Gopher client, and supports the Gopher+ extensions that add new
features, such as letting the server tell you the size of a file. Gopher + items
can be displayed in alternate views, and may have fill-out forms associated
with them.

To get connected to Gopher, download TurboGopher as follows:

1. Using Fetch , Anarchie , or another FTP  client, download
TurboGopher from ftp://ftp.tidbits.com/pub/tidbits/tisk/tcp/ or
f t p : / / b o o m b o x . m i c r o . u m n . e d u / p u b / g o p h e r / M a c i n t o s h -
TurboGopher/or from the Internet Starter Kit disk.

2. Double-click the TurboGopher icon to launch the program, which is
configured to connect to the home Gopher server at the University of
Minnesota. You will see the main menu, which appears as a line of
folders (see the figure that follows). Double-click one folder to open it
and begin navigating. A good place to start is “Information About
Gopher.”
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Gopher, Searching, and Finding Information Gopherspace, the
popular term for the network of Gopher servers, is huge. Navigating
Gopherspace becomes possible with Veronica , which allows searches of
either only Gopher directories or of all items in Gopherspace. Jughead ,
another search engine, allows you to conduct more focused searches. Once
you find a file you want, TurboGopher can download several files at once and
can obtain files while you continue to browse other Gopher sites. Helper
applications work with TurboGopher to process data such as GIF images .

See Also
Anarchie, Archie, Fetch, File Transfer Protocol, Internet Services, Jughead,
GIF Images, TurboGopher, Veronica

Gopher Searching
See 
Gopher, Jughead, Veronica

Gopher Software
See 
TurboGopher
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Go To Command
This command, which appears in many applications, enables you to jump
from the current page to any numbered page within the document. Go To
appears on the Edit menu, and when chosen, it displays a dialog box
asking you to insert the number of the page you want to go to.

To go directly to a particular page using the Go To command, follow these
steps:

1. Choose Go To (usually -G) from the Edit menu of your application.

2. Enter the page number you want to go to.

3. Click the OK button to go to that page.

See Also
Dialog Box; Edit Menu

Gouraud Shading
See 
Rendering

G



Government Simulation Games
See 
Sim Games

Grammar Checker
Like the spelling checker, a grammar checker is built into most word
processors. It works much like the spelling checker, comparing text against
a set of rules. Unlike the spelling checker, however, the grammar programs
often make mistakes, flagging a perfectly good sentence as incorrect and
occasionally skipping mistakes that an elementary school student would
catch. You can customize the grammar checker to ignore some rules and to
use either the formal or casual rule set. Doing so helps avoid some of the
“false” errors. Most grammar checkers also rate your writing according to a
readability index, determining how many years of school you’d have to have
in order to understand the material. These indices are based on the ratio of
long words to short words in a sentence, and really shouldn’t be taken too
seriously. The readability index for this paragraph is 10.44.

Graphics Compressor
This QuickTime compressor only works with 8-bit graphics. If you attempt to
compress a 16-bit graphic, it is converted to 8-bit during the compression
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routine. While this compressor can be used to compress sequences, it is not
recommended. Use the Animation Compressor  instead.

See Also
Animation Compressor; Asymmetrical Compressors; Compressor; Drop Frames;
Spatial compression; Symmetrical Compressors; Temporal Compression

Graphics Coprocessors
See 
Coprocessors, Types of
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Graphic design is the process of applying aesthetic principles in the creation
and arrangement of type, pictorial elements, and other graphic images in
printed matter or in electronic displays. A graphic is usually defined as any
element printed on a two-dimensional surface; however, computer-based
technologies have expanded that meaning to include elements intended only
for display on a computer monitor, television, or other electronic display
device.

For example, multimedia displays that include both two-dimensional and
three-dimensional graphics should generally follow the basic principles of
graphic design. A home page on the World Wide Web or the display graphics
of an online service or of a software application are certainly subject to
graphic design precepts.

Although graphic design is thought of as an art form and follows many of
the same principles as fine art, it differs to the extent that it is more
commercially oriented. Communication is the basic goal of all art, but
graphic design exists almost solely for that purpose. In the past, graphic
designers have been called commercial artists—a category which also
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includes illustrators. Many graphic designers have an artistic temperament
and may have been trained in the fine arts (painting, drawing, sculpture,
and so on), or they may have participated in commercial art or advertising
degree programs at a college or university.

Desktop publishing technology has attracted many more people to the field of
graphic design, and many lack any background at all in fine art or
commercial art.

Communication is such an important goal in graphic design, that creativity
and self-expression can be much more restricted than in fine arts. A
conservative designer follows the principle of "form follows function" and
does not allow artistic expression to obscure the message. For example, using
a decorative typeface that is beautiful in form but difficult to read as body
copy would be considered inappropriate. This type of graphic design is
necessary for most published material, and few milieus exist for designers
who wish to experiment and break the rules.

The rules of graphic design involve fundamentals that govern the placement
of elements on a page. Rules have also evolved for the selection and
formatting of type. In fact, type may be thought of as the primary element of
graphic design. The proper use of type often distinguishes an experienced
professional from a novice. In fact, finesse and attention to detail are often
distinguishing characteristics in a well-designed publication. For more
information about the basic principles of design and typography, read The
Non-Designer's Design Book by Robin Williams (Peachpit Press).
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Graphics File Formats
Mac graphics files come in two basic flavors—vector  and bitmapped —but
there are a lot of variations on those two themes. Different types of graphics
and different uses demand different file formats.

Some formats are readable only by the program that creates them—for
example, Freehand’s  native format; others can be read and written by a
variety of applications, as Freehand can write EPS  files that can be opened
and imported by other programs.

The original Mac format for graphics was MacPaint, the native format used
by a paint program of the same name that was bundled with the first Macs in
1985. It was—and still is—the most basic bitmap file format, only capable of
saving black-and-white files. Then, eventually, came TIFF, a much more
advanced bitmapped format that supports 24-bit color in RGB and CMYK
modes. It’s a very stable, cross-platform format that’s the standard for scans
and other photo-based art that must eventually be printed out on a high-
resolution printer or imagesetter.

The vector graphics file formats developed slightly later, as there wasn’t
even a program that could manipulate EPS (Encapsulated Post Script) files
until 1988, when Adobe’s Illustrator 88 came along. But the EPS format is
exceptional in that it unlocks the power of PostScript printers and
imagesetters, allowing complex graphics made of basic points and lines to be
scaled, skewed, rotated, shaded, and more. EPS files are typically a fraction of
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the size of their TIFF cousins, they’re cross-platform compatible, and they’re
very stable…”

PICT is a simple screen display format that’s part of the Mac’s basic
architecture, but it’s not meant for printing. It’s fine for multimedia work or
slide and on-screen presentations.

These days, TIFF , EPS, GIF , and JPEG  are much more common names in the
world of graphics formats. TIFF and GIF are used for bitmapped graphics,
such as scans, while EPS is the most common format for vector graphics on
the Mac. JPEG is a compression standard for color bitmapped images that can
drastically reduce file size with little loss of image quality.

Macs can also read formats commonly used on other platforms, such as the
BMP, CGM, and PCX formats used by PCs.

See Also
Bitmapped Graphics; EPS; Freehand; GIF; JPEG; MacPaint; PICT; TIFF; Vector
Graphics
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Graphics Interchange File
See 
GIF

Graphics Tablets
If you do serious graphics work or enjoy drawing with a pen-based object
rather than a mouse  or trackball , you might need a graphics tablet. True,
enough, you can draw and paint with a mouse, but not with the degree of
control that a pen and tablet provide. For those who have highly developed
skills with pen and ink or brushes and paint, a pressure-sensitive pen and
tablet provide the familiar feedback of working with these real-world tools.

Tablets can be used in almost any application. For example, editing a
spreadsheet or a database is easier if you can tap directly on the cell or field
you want to change and not have to slide the cursor all over the screen.
Complex applications, from desktop publishing to computer-aided design
(CAD), often have special palettes and function keys; tapping on them saves
time. Tablets can also be helpful for people entering music into a notation
application via its note palette.

Graphics tablets (shown in the illustration) are radio-frequency based
devices. When you draw with the stylus, it exchanges tiny radio signals with
the tablet through a grid of wires that crisscross the drawing area. The tablet
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determines the location of the stylus and transmits the location to the Mac.
Most graphics tablets are pressure-sensitive: the harder you press the palette
with the stylus, the darker or wider the pen line.

Most graphics tablets (also called digitizing tablets) are covered with a clear
plastic sheet (an overlay). You can slip artwork you wish to trace under the
sheet, or draw with ink-filled cartridges inserted into the stylus on tracing
paper to see what you are drawing on the screen.

The biggest differences of graphics tablets from mice or trackballs are the
following:

• Working area. This factor refers to the actual size of the tablet’s
pressure-sensitive input area. Bigger tablets are more expensive;
smaller tablets can be more comfortable if you like to hold them in
your lap as you would a sketch pad.

• Resolution. The resolution of a tablet is measured in the number of
divisions per square inch. If you create finely detailed illustrations or
complex CAD documents, you need more expensive models that support
higher resolutions. The down side of high resolution tablets is that the
amount of data throughput increases and processor performance slows
down due to the large amounts of data that must be processed with each
stylus movement.

Pressure-sensitive pens emulate real-world tools and, with compatible
software, enable you to work on screen just as you would on canvas. Press
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down on a brush, and the stroke widens. Pressing lightly on a watercolor
brush creates a tiny drop of color. Nearly all major graphics applications,
such as Fractal’s Painter and Adobe Photoshop, support pressure-sensitive
pens. Many pens do not require batteries, which usually means that all the
position and pressure sensing takes place on the tablet. Most pens used with
graphics tablets are cordless. Such cordless pens can be filled with ink for an
intuitive, natural feeling. You can also use such a pen to actually produce an
electronic signature.

Graphics tablets and styluses are absolute-motion pointing devices. The stylus
has the ability to tell the Mac its physical location on the tablet, and that
location is mapped to an exact location on the screen. When you move the
stylus on the palette, the cursor on the screen moves to the same location on
the screen. Graphics tablets are able to operate in relative-motion (like mice
and trackballs ), but their ultimate benefit is their ability to trace exact
positions. The graphics tablet and stylus also provide better pixel precision
than mice or trackballs. Mice and trackballs can discern approximately 200 to
300 units of movement per inch. Graphics tablets detect 1,000 units or more
per inch (known as resolution and measured in lines per inch (LPI). The
higher the pointing device’s resolution, the better it will be for use in
precise drawing.

Tablets have historically been serial devices  because the Apple Desktop
Bus port  is not fast enough to handle the amounts of data they generate.
Some manufacturers, however, have introduced products that work with the
ADB port. Tablets also tend to draw more power than most ADB devices can
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CAD applications at Lockheed, which
markets them through CalComp. 6 by 9
iches, 12 by 12 inches, 12 by 18 inches
tablets. 2,540 lpi with accuracy of ±0.01
inches. $395 to $595

Summagraphics Microgrid Ultra ADB Backlit models,
ADB port compatible. 17 by 24 inches to
44 by 60 inches. $3,299 to $8,699

Hitachi Digital Graphics StudioPadSmall tablet $199.99

See Also
Absolute Versus Relative Motion; Apple Desktop Bus; Keyboards; Mice;
Pen/Handwriting Devices; Serial Ports; Trackballs; Touchpads; Touch Screens

Graphics Terms
Active Display Area —That part of an image visible on the display screen.

ADC (Analog to Digital Converter)— A device that changes analog real
—world information into digital information that the computer can store and
manipulate.

Algorithm —A formula that is used to initiate an operation.

Animation —Frames of a sequence that the eye defines as moving.
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Aspect Ratio —Width to height ratio. Common ratios for computer
videographics and multimedia are 3:2 and 4:3, though desktop publishing
pages can be produced at any needed ratio.

Backup —a saved file that duplicates another file.

Batch Processing —An operation that targets more than one file at a time.

Bit Map —A graphic whose content is determined by its collection of picture
elements or pixels.

Blue Screen —A blue background that is seen by the system as transparent
so that another scene or graphic can be placed behind the foreground image.

Brightness —Luma or luminescence.

Buffer —A area of temporary memory in the computer used to store data.

Byte —A unit that represents a sequence of eight bits for computation and
storage.

CAD (Computer Aided Design)— using a computer to originate and /or
modify a design.

CAM (Computer Aided manufacturing)— Computerized process for
manufacturing products direct from on —screen data.

Color Key —A special effect used to composite still or moving images in film
and video. Sometimes called blue screen.
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Color Picker —A Mac palette screen [Control panel device] used to select
colors.

Compression —A process that squeezes data into a smaller space, for example,
the JPEG file format.

Contrast —The difference between the darks and lights in an image.

Cross Platform —referring to a file that can be accessed on more than one
computer type or platform.

Data/Resource Forks —Disk files with the proper data needed to reconstruct
a saved file.

Decompression —A reverse procedure used to read compressed files and
reconstruct them back to their original state.

Digital —A medium that has only a binary or on/off signal.

Digitize —To grab data from the real world and translate it into digital form
so that the computer can display it.

Dithering —Creating intermediate colors between any two choices by a
system of dots.

Dots per Inch (DPI)— the number of discreet dots an output device can
print per inch (horizontal x vertical).

Frame Grabber —A video digitizer with onboard storage capacity built in.
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Grayscale —usually refers to a spectrum of 256 gray levels.

Hard Copy —Printed or film computer output.

Histogram —A graphing of the brightness values in every pixel in a raster
image.

Image Processing —Changing the elements in an image through an effect
or specific algorithm.

Macintize —To place White as the first color and black as the last color in the
image’s palette.

Multimedia —The combining of more than one media in a presentation, as
for example, sight and sound.

Palette —the range of hues in a defined spectrum.

Palette Number Index —Considering that the first color (White in a MAC
palette) is number zero, the palette number of any color may be calculated by
finding its numeric position.

Palette Switching —More than one palette in use in a sequence of images.
This may lead to slower animation playback and can cause discomforting
flickering.

Pixel (Picture Element)— The smallest element that a raster image
contains whose actual size and shape is determined by the resolution of the
image on screen and the extent to which the display device can accommodate
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that size.

Pixel Depth —The number of bits needed to store a pixel, stated in
increments that double with each succeeding level. A one bit pixel can store
two colors, 2 bits four colors, 3 bits eight colors, 4 bits sixteen colors, 5 bits 32
colors, 6 bits 64 colors, 7 bits 128 colors, and 8 bits 256 colors (or shades of
gray). Common pixel depth for color work is 24 bits or sixteen million plus
colors, while 32 bit pixel depth includes 24 bits of color and an 8 bit “alpha
channel” of grays.

Plotter —An output device that uses moving pens to create a graphic in
response to computer signals.

Preferences —Settings that determine how software is configured.

RGB (Red, Green, Blue)— the three primary colors of the electron guns in
a video compatible system.

Remap —To change the colors in a palette to match another palette.

Scaling —Changing the size of an image.

Scan —To place an image in a flatbed digitizer for translating  image data to
digital format.

Script —A series of encoded instructions that initiate an action.

Translate —Converting one format to another.

Threshold —Setting a level at which an operation will take place.
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Vector Graphics —Image elements defined by their directional heading and
length.

Video Digitizer —A device that captures an image from a video source,
whether a camera, VCR, or video still camera. A professional video digitizer
can capture a single frame of video from a moving sequence in real time.

GraphicConverter
Shareware ($35) program by Thorsten Lemke that converts edits graphics
files in a wide variety of formats. Especially useful in preparing or
converting files for presentation on the World Wide Web,  the graphical
part of the Internet .

Installation is simple: downloading GraphicConverter from the Internet
creates a preferences file in your System Folder. Double-click the program to
launch it.

To convert a file, simply choose “Open” from the “File” and navigate to the
document. Choose “Save as” from the “File” menu. Choose a new graphics
format from the “Format” pull-down menu in the right half of the “Save as”
window that opens on-screen.

After converting a file you can check a box in the “Save as” window to
automatically compress that file with the shareware application StuffIt, if
you already have StuffIt installed on your Mac.
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GraphicConverter saves GIF  files as GIF89 format, which allows
transparent  images and Multipart GIF  animation. It also has a “Slide
Show” feature, which plays all the image files in a designated folder, one
after another.

Recent versions of GraphicConverter are accelerated for the PowerMac. The
program requires a Mac with color QuickDraw, System 7 and at least 2MB of
memory.

See Also
GIF; GIFConverter; Internet; Multipart GIF Images; Transparent Images;
World Wide Web

Graphics Programs for Children
See 
KidPix Studio

Gravure
See 
Printing Methods, Traditional
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Gray Disk Icon
If you use the Eject Disk  command on the Special menu  to eject a disk
from the disk drive, the disk ejects, but a gray "ghosted" disk icon is left on
the desktop , as shown in the figure. To remove this gray disk icon, drag the
icon into the Trash,  and it disappears. If you drag the disk icon to the Trash
or use the Put Away  command on the File menu  to eject a disk, the gray
disk icon does not appear.

If you drag the ghost disk icon into the Trash and it doesn't go away,
resources of that disk are still in use. In System 7  and higher, you are be
met with a dialog box that states, "The disk (the disk's name appears here)
cannot be put away because it contains items that are in use." You have to
click OK to continue. If this should happen, re-open the disk and make
certain all the documents on the disk have been properly closed.

This ghosting of the disk can create additional problems. If you double-
click  the ghosted disk, the Mac brings up a dialog box asking you to reinsert
the original disk. You can make this dialog box go away by hitting -.
(period) on your keyboard or by inserting the original disk.

You can run into more problems if you happen to eject a disk using the Eject
Disk command and that disk had an open window when you ejected it. If you
try to close that window, perhaps to reduce clutter on your desktop, you are
met with a dialog box insisting that you reinsert your disk. It asks for the disk
because a change to the disk has been made (a window was closed) and the
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information needs to be updated on the original disk. Having your system
demand disks that have already been ejected can be a frustrating experience.

Because of the problems that ghosting disks cause, many people prefer to use
the Put Away  command ( -Y) rather than using Eject Disk. The Put Away
command dismounts and ejects the disk, but does not leave the ghosted
version of the disk on the desktop.

See Also
Click and Drag; Disk; Desktop; Eject Disk; File Menu; Ghost Disk; Put Away;
Special Menu; Trash

Gray Component Replacement
See 
GCR

Gray Levels
There is a direct relationship between gray or color levels and output
resolution in digital halftone production. The dots in digital halftones  are
composed of a matrix of smaller dots made by a laser imaging device. These
are sometimes called laser spots or machine spots. The grouping of these
smaller dots, or spots, is called a digital halftone  cell. The number of these
smaller dots within the digital halftone cell determines the potential gray or
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color levels of the cell. If, for example, a cell contains only four of the
smaller dots, it has the potential to represent five gray levels: no dots (white),
one dot, two dots, three dots, and four dots (black). In other words, a halftone
image made up of these cells would be severely posterized because the cells do
not contain enough laser spots to create the illusion of continuous tone. The
image would have only three grays in addition to black and white.

At lower output resolutions (300 to 1200 dpi), it is difficult to achieve good
halftones because there is a trade-off between the halftone screen
frequency (lpi) and the device output resolution (dpi). This is because a
lower screen frequency provides more gray levels at a given output
resolution. The following formula can be used to determine gray levels:

(dpi/lpi)2 + 1 = gray levels. A 100 lpi halftone, for example, printed on a 600
dpi laser printer has some posterization because it has only 37 gray levels.
(600 divided by 100 equals 6. 6 squared equals 36. 36 plus 1 equals 37.)
Decreasing the lpi requirement to 65, however, yields an image with 82 gray
levels—still not a great halftone but better than 37 levels. The object is to
obtain as many gray levels as possible at a given screen frequency;
therefore, it becomes obvious that higher output resolutions are key.

Another factor must be considered when working with gray levels.
PostScript  Level 1 devices are limited to 256 gray levels. Level 2 PostScript
supports more, but most experts agree that there is no point in striving for
more than 256 levels. There is no harm in having more gray levels than are
necessary, but one should avoid having too few. To determine the optimum
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output resolution required for a given screen frequency, a formula using the
square root of 256 has been devised: lpi x 16 = dpi. Therefore, a 133 lpi
halftone requires an output device with a dpi rating of at least 2128 (133
lpi[ts]16 = 2128 dpi). Naturally, this is rounded off to 2400 dpi, a common
resolution for imagesetters.  This example provides 325 gray levels—more
than are needed but better than not enough!

See Also
Digital Halftones; Halftones; Resolution Measurement

Grayed Commands
If you go to a menu and the name of a command is grayed, that command is
not available. A grayed-out command is also referred to as dimmed. Commands
that are available for use appear in black type.

See Also
Command; Font; Menu

Grayscale
See 
Image Scanning
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GrayShare
See 
Printers, Inkjet

Grow Box
See 
Size Box

Guides
In many graphics and page layout applications, users can click on the ruler
at the edge of a document window and drag to pull a positioning guide onto
the page. Often, users can specify that objects moved near the guide should
“snap” to the guide, facilitating alignment, and some programs also allow
users to specify exactly how close an object must be to the guide to be affected
by it.

See Also
Drawing Applications; Guides; Page Layout Applications; Rulers

Gutter
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See 
Printing Terms

Gutter Margins
See 
Margins and Tabs

Gwydion Project
See 
Dylan

GX Fonts
Rather than the 256 characters that the Mac’s system would previously allow

in any font, GX fonts can contain—get ready for this—2562, or 65,536,
characters. That leaves a lot of room for things like expert and swash
characters, ornaments, ligatures, and fractions. And non-Roman alphabets,
such as in Asian languages, can be entirely contained in one font. GX fonts
also have room for information about how an application should use a
font—features like automatic ligature substitution, optical alignment (often
lines that are centered don’t look centered), true drawn small caps, hanging
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punctuation, and font-level kerning and tracking.

Adobe’s Garamond Plus combines the Regular, Expert Set, Titling, and
Alternate sets of Garamond. It includes accented characters, small caps,
ligatures, superior and inferior numbers (drawn for that purpose, not just
reduced), fractions, swashes, and ornaments. GX-aware applications allow
users to enable and disable automatic use of any of these options through
menu choices.

Another Adobe face, Caflisch Script, is a connecting script that uses the extra
character slots for variations on each character that are chosen
automatically based on which letters precede and follow it. It can also choose
variations randomly, to give a more hand-drawn feel to the type.

GX could also mean an end to the screen font/printer font dichotomy of
PostScript fonts, because GX PostScript fonts are one-piece, like TrueType
fonts, and live in suitcases. For now, though, few page layout and graphics
applications support GX.

See Also
Bitmapped Fonts; Fonts; Outline Fonts; PostScript; TrueType; Typesetting
Terms
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